
Model created in COMSOL Multiphysics 6.4
Microlithography Lens
This model is licensed under the COMSOL Software License Agreement 6.4.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


Introduction

Microlithography is the process of imprinting small patterns (feature sizes less than 10 μm) 
onto a surface. It is an invaluable method in the production of integrated circuits due to 
the constantly increasing demand for smaller feature sizes and greater transistor density.

In photolithography, a wafer is first coated with a layer of photoresist, a special material 
that becomes more soluble in a certain liquid (called the developer) when exposed to 
radiation. The photoresist is then illuminated with a beam that has been sent through a 
photomask, a plate that selectively obstructs light in a specific pattern. The image of the 
mask is projected onto the surface of the photoresist. Thus, when the developer solution 
is applied to the photoresist, only the illuminated parts of the photoresist layer are washed 
away. The exposed parts of the underlying wafer can then be etched while the photoresist 
shields other parts of the wafer. Finally, the remaining photoresist is washed off.

An image of the photomask is thus etched into the surface of the wafer. Usually the light 
from the photomask is focused by a lens system with a magnification less than unity, so the 
projected image of the circuit pattern is smaller than it appears on the mask.

In order to manufacture devices with ever-decreasing feature size, the wavelengths of 
radiation used in photolithography have decreased over time. Krypton fluoride (KrF, 
248 nm wavelength) and argon fluoride (ArF, 193 nm) lasers have been successfully used 
in photolithography for the production of microchips. Since these wavelengths are in the 
ultraviolet part of the electromagnetic spectrum, photolithography at these wavelengths is 
sometimes called UV photolithography, DUV (deep ultraviolet) photolithography, UV 
microlithography, or DUV microlithography.

The choice of material in a microlithography lens system is more limited than in camera or 
telescope lenses, because many optical glasses have reduced transmittance to UV light 
compared to visible light. DUV systems often use glasses composed of fused silica (quartz) 
or calcium fluoride (CaF) which have high transmittance in this wavelength range.

Lens systems for UV microlithography tend to have a rather large number of elements, 
each of which can be quite heavy and must be machined and positioned very accurately, 
so these lens systems can become quite expensive.

This tutorial demonstrates how to perform geometrical optics simulation in a 21-element 
fused silica microlithography lens with a numerical aperture (NA) of 0.56, to be used at a 
wavelength of 248 nm (KrF laser). The lens, which has a total length of 1 meter, has a 
magnification of -0.25 with excellent image quality over a 23.4 mm image circle.
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Model Definition

The optical prescription of the UV microlithography lens consists of 21 spherical lens 
elements. For each element, the radii of curvature of the two surfaces, the center thickness, 
and the lens diameter must be defined, as well as the spacing between successive elements. 
The distance to the object plane and the image plane must also be specified. Altogether 
the optical prescription includes 2 × 21 + 2 or 44 rows of data.

The detailed optical prescription, given in Ref. 1, is shown in Table 1.

The geometry is constructed using parts from the Ray Optics Module Part Library. All of 
the lenses were constructed using the Spherical Lens 3D part. The object and image planes 
are instances of the Circular Planar Annulus part with an inner radius of zero.

When constructing a geometry in COMSOL to be used in a Geometrical Optics ray trace, 
it is important to appreciate that the order in which optical elements are placed in a 
geometry sequence does not affect the results of the trace. However, it is convenient to 
place optical elements relative to one another. This can be achieved by taking one of the 
built-in work planes in a Part Instance as the reference for the placement of the next Part 
Instance. The resulting lens geometry sequence is shown in Figure 1. Detailed instructions 
for creating the geometry can be found in Appendix — Geometry Instructions.

TABLE 1:  OPTICAL PRESCRIPTION FOR THE MICROLITHOGRAPHY LENS

Surface Radius of curvature Thickness Diameter Material

0 0.0000[mm] 107.954[mm] 46.80[mm] Vacuum

1 -617.8800[mm] 30.375[mm] 61.30[mm] Silica

2 -207.0830[mm] 0.934[mm] 64.20[mm] Vacuum

3 +201.9739[mm] 68.636[mm] 64.75[mm] Silica

4 -416.6217[mm] 0.865[mm] 59.60[mm] Vacuum

5 +460.0439[mm] 7.061[mm] 55.25[mm] Silica

6 +179.6999[mm] 15.608[mm] 55.25[mm] Vacuum

7 -373.0162[mm] 6.952[mm] 54.90[mm] Silica

8 +249.4960[mm] 30.983[mm] 54.35[mm] Vacuum

9 -2591.2000[mm] 11.541[mm] 55.90[mm] Silica

10 +229.2357[mm] 33.165[mm] 56.85[mm] Vacuum

11 -82.3025[mm] 11.524[mm] 57.45[mm] Silica

12 +569.8191[mm] 9.159[mm] 74.85[mm] Vacuum

13 +5523.6000[mm] 36.703[mm] 79.45[mm] Silica
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14 -156.8200[mm] 0.889[mm] 85.05[mm] Vacuum

15 +610.3354[mm] 41.168[mm] 100.20[mm] Silica

16 -221.8862[mm] 0.883[mm] 101.90[mm] Vacuum

17 +528.5938[mm] 26.903[mm] 104.20[mm] Silica

18 -570.2004[mm] 0.883[mm] 104.05[mm] Vacuum

19 +423.5775[mm] 21.883[mm] 101.00[mm] Silica

20 -1396.3000[mm] 0.883[mm] 100.00[mm] Vacuum

21 +203.9075[mm] 22.715[mm] 91.85[mm] Silica

22 +835.4548[mm] 67.972[mm] 89.70[mm] Vacuum

23 -735.8990[mm] 8.386[mm] 57.50[mm] Silica

24 +104.6386[mm] 23.616[mm] 50.55[mm] Vacuum

25 -184.6683[mm] 11.034[mm] 49.95[mm] Silica

26 +288.7053[mm] 58.171[mm] 46.10[mm] Vacuum

27 -74.5663[mm] 11.343[mm] 51.85[mm] Silica

28 +2319.0000[mm] 11.371[mm] 63.05[mm] Vacuum

29 -283.4504[mm] 22.211[mm] 64.75[mm] Silica

30 -142.5176[mm] 1.323[mm] 69.90[mm] Vacuum

31 -5670.5000[mm] 39.484[mm] 81.85[mm] Silica

32 -146.6908[mm] 0.883[mm] 86.45[mm] Vacuum

33 +654.7531[mm] 37.168[mm] 94.75[mm] Silica

34 -347.7071[mm] 0.883[mm] 96.35[mm] Vacuum

35 +254.9142[mm] 31.600[mm] 96.45[mm] Silica

36 +2133.2000[mm] 0.883[mm] 94.50[mm] Vacuum

37 +164.8042[mm] 27.885[mm] 89.95[mm] Silica

38 +349.3775[mm] 0.884[mm] 86.00[mm] Vacuum

39 +108.9816[mm] 73.045[mm] 77.70[mm] Silica

40 +75.6698[mm] 54.069[mm] 46.50[mm] Vacuum

41 +46.2841[mm] 16.956[mm] 25.70[mm] Silica

42 +99.3161[mm] 13.168[mm] 19.85[mm] Vacuum

43 0.0000[mm] 0.000[mm] 11.70[mm] Vacuum

TABLE 1:  OPTICAL PRESCRIPTION FOR THE MICROLITHOGRAPHY LENS

Surface Radius of curvature Thickness Diameter Material
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Figure 1: Microlithography lens geometry sequence. The rays propagate from left to right.

Results and Discussion

The ray diagram of the microlithography lens for three different field angles is shown in 
Figure 2. For each of the three field angles, the average ray position in the image plane is 
computed, and then the distance from each ray’s final position to this average position is 
computed, forming the color expression along the rays.

A spot diagram of rays in the image plane is shown in Figure 3. Here the color expression 
indicates the angle of incidence of each ray at the image plane.
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Figure 2: Ray diagram of the microlithography lens.

Figure 3: Spot diagram of the microlithography lens.
6 |  M I C R O L I T H O G R A P H Y  L E N S



References

1. J.B. Caldwell, “All-fused Silica 248-nm Lithographic Projection Lens,” Opt. Photonics 
News, vol. 9, no. 11, pp. 40–41, 1998.

2. W. Smith, Modern Lens Design, 2nd ed., McGraw Hill, 2005.

Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
microlithography_lens

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics > Ray Optics > Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 2
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Name Expression Value Description

NA 0.56 0.56 Numerical aperture

mag 0.25 0.25 Magnification
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M I C R O L I T H O G R A P H Y  L E N S  G E O M E T R Y  S E Q U E N C E

Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in the appendix. Following insertion, the lens definitions will be available in 
the Parameters node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

4 In the Label text field, type Microlithography Lens Geometry Sequence.

5 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

6 Browse to the model’s Application Libraries folder and double-click the file 
microlithography_lens_geom_sequence.mph.

7 In the Geometry toolbar, click Build All.

8 Click the Orthographic Projection button in the Graphics toolbar.

9 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View. This will orient the view to place the optical axis (z-axis) horizontal and 
the y-axis vertical. Compare the resulting geometry to Figure 1.

Disable the analysis of the geometry as the remaining small geometric details can be 
kept.

10 In the Model Builder window, click Microlithography Lens Geometry Sequence.

11 Locate the Cleanup section. Clear the Automatic detection of small details checkbox.

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation 
section.

3 In the Maximum number of secondary rays text field, type 0.

4 Locate the Material Properties of Exterior and Unmeshed Domains section. From the 
Optical dispersion model list, choose Absolute vacuum.

5 Locate the Additional Variables section. Select the Compute optical path length checkbox.

alpha atan(NA)*mag 0.12762 rad Cone angle

nhex 25 25 Number of hexapolar rings

Name Expression Value Description
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Medium Properties 1
1 In the Model Builder window, under Component 1 (comp1) > Geometrical Optics (gop) 

click Medium Properties 1.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the n list, choose User defined. In the associated text field, type 1.5084.

Material Discontinuity 1
1 In the Model Builder window, click Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never.

Ray Properties 1
1 In the Model Builder window, click Ray Properties 1.

2 In the Settings window for Ray Properties, locate the Ray Properties section.

3 In the λ0 text field, type 248[nm].

Obstructions
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Image
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image).

Release from Grid 1
1 In the Physics toolbar, click Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Ray Direction Vector section.

3 From the Ray direction vector list, choose Conical.

4 From the Conical distribution list, choose Hexapolar.

5 In the Nθ text field, type nhex.

6 Specify the r vector as

0 x
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7 In the α text field, type alpha.

Release from Grid 2
1 Right-click Release from Grid 1 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 In the qy,0 text field, type D_0/4.

Release from Grid 3
1 Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 In the qy,0 text field, type D_0/2.

M E S H  1

Size 1
1 In the Mesh toolbar, click Sizing and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Clear Apertures.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section.

7 Select the Maximum element size checkbox. In the associated text field, type 5[mm].

Size 2
1 In the Mesh toolbar, click Sizing and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 From the Selection list, choose Obstructions.

5 Locate the Element Size section. From the Predefined list, choose Extra fine.

Free Tetrahedral 1
1 In the Mesh toolbar, click Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, click Build All.

0 y

1 z
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S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 In the Lengths text field, type 0 1.5.

5 In the Study toolbar, click Compute.

R E S U L T S

Ray Trajectories (gop)
1 In the Settings window for 3D Plot Group, locate the Color Legend section.

2 From the Position list, choose Bottom.

3 Select the Show units checkbox.

Surface 1
1 In the Ray Trajectories (gop) toolbar, click Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Coloring list, choose Uniform.

4 From the Color list, choose Blue.

Transparency 1
In the Ray Trajectories (gop) toolbar, click Transparency.

Color Expression 1
1 In the Model Builder window, expand the Results > Ray Trajectories (gop) > 

Ray Trajectories 1 node, then click Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel).

4 From the Unit list, choose µm.

5 Locate the Coloring and Style section. From the Color table list, choose HeatCameraLight.

6 From the Color table transformation list, choose Reverse.

7 In the Ray Trajectories (gop) toolbar, click Plot. Compare the resulting image to 
Figure 2.

Spot Diagram
1 In the Results toolbar, click 2D Plot Group.
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2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

4 Select the Show units checkbox.

Spot Diagram 1
1 In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

2 In the Settings window for Spot Diagram, click to expand the Annotations section.

3 Select the Show spot coordinates checkbox.

4 From the Coordinate system list, choose Global.

5 In the Display precision text field, type 7.

6 In the Spot Diagram toolbar, click Plot.

Color Expression 1
1 In the Spot Diagram toolbar, click Color Expression.

2 In the Settings window for Color Expression, click Replace Expression in the upper-right 
corner of the Expression section. From the menu, choose Component 1 (comp1) > 
Geometrical Optics > Ray properties > gop.phii - Acute angle of incidence - rad.

3 Locate the Expression section. From the Unit list, choose °.

4 In the Spot Diagram toolbar, click Plot. Compare the resulting image to Figure 3.

Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

M I C R O L I T H O G R A P H Y  L E N S  G E O M E T R Y  S E Q U E N C E

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Microlithography Lens Geometry 
Sequence in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.
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G L O B A L  D E F I N I T I O N S

Parameters 1: Thicknesses
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Thicknesses in the Label 
text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
microlithography_lens_geom_sequence_thicknesses.txt.

Parameters 2: Radii
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 2: Radii in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
microlithography_lens_geom_sequence_radii.txt.

Parameters 3: Diameters
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3: Diameters in the Label 
text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
microlithography_lens_geom_sequence_diameters.txt.

P A R T  L I B R A R I E S

1 In the Geometry toolbar, click Part Libraries.

2 In the Model Builder window, under Component 1 (comp1) click 
Microlithography Lens Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module > 3D > Apertures and Obstructions 
> circular_planar_annulus in the tree.

4 Click Add to Geometry.
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M I C R O L I T H O G R A P H Y  L E N S  G E O M E T R Y  S E Q U E N C E

Object
1 In the Model Builder window, under Component 1 (comp1) > 

Microlithography Lens Geometry Sequence click Circular Planar Annulus 1 (pi1).

2 In the Settings window for Part Instance, type Object in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Click to expand the Boundary Selections section. In the table, select the Keep checkbox 
for All.

5 Click Build All Objects.

6 Click the Orthographic Projection button in the Graphics toolbar.

7 In the Graphics window toolbar, click next to Go to Default View, then choose 
Go to ZY View.

8 Click the Zoom Extents button in the Graphics toolbar.

9 In the Graphics window toolbar, click next to Clipping, then choose 
Add Clip Plane.

10 In the Graphics window toolbar, click next to Clipping Active, then choose 
Show Gizmos.

11 In the Graphics window toolbar, click next to Clipping Active, then choose 
Show Frames.

P A R T  L I B R A R I E S

1 In the Geometry toolbar, click Part Libraries.

2 In the Model Builder window, click Microlithography Lens Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module > 3D > Spherical Lenses > 
spherical_lens_3d in the tree.

4 Click Add to Geometry.

5 In the Select Part Variant dialog, select Specify clear aperture diameter in the 
Select part variant list.

6 Click OK.

Name Expression Value Description

d0 D_0 93.6 mm Diameter, outer

d1 0 0 m Diameter, inner
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M I C R O L I T H O G R A P H Y  L E N S  G E O M E T R Y  S E Q U E N C E

Lens 1 (Surfaces 1 and 2)
1 In the Model Builder window, under Component 1 (comp1) > 

Microlithography Lens Geometry Sequence click Spherical Lens 3D 1 (pi2).

2 In the Settings window for Part Instance, type Lens 1 (Surfaces 1 and 2) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Object (pi1).

5 From the Work plane list, choose Surface (wp1).

6 Find the Displacement subsection. In the zwi text field, type T_0.

7 Locate the Boundary Selections section. Click to select row number 2 in the table.

8 Click New Cumulative Selection.

9 In the New Cumulative Selection dialog, type Clear Apertures in the Name text field.

10 Click OK.

11 In the Settings window for Part Instance, locate the Boundary Selections section.

Name Expression Value Description

R1 R_1 -617.88 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_2 -207.08 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_1 30.375 mm Center thickness

d0 max(D_1,D_2) 128.4 mm Lens full diameter

d1 D_1 122.6 mm Diameter, surface 1

d2 D_2 128.4 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2
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12 In the table, enter the following settings:

13 Click to select row number 4 in the table.

14 Click New Cumulative Selection.

15 In the New Cumulative Selection dialog, type Obstructions in the Name text field.

16 Click OK.

17 In the Settings window for Part Instance, locate the Boundary Selections section.

18 In the table, enter the following settings:

19 Click Build Selected.

20 Click the Zoom Extents button in the Graphics toolbar.

Lens 2 (Surfaces 3 and 4)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 2 (Surfaces 3 and 4) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Name Keep Physics Contribute to

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

R1 R_3 201.97 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_4 -416.62 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_3 68.636 mm Center thickness

d0 max(D_3,D_4) 129.5 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 1 (Surfaces 1 and 2) (pi2).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_2.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 3 (Surfaces 5 and 6)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 (Surfaces 5 and 6) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear D_4 119.2 mm Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

R1 R_5 460.04 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_6 179.7 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_5 7.061 mm Center thickness

d0 max(D_5,D_6) 115.2 mm Lens full diameter

d1 0 0 m Diameter, surface 1

Name Expression Value Description
17 |  M I C R O L I T H O G R A P H Y  L E N S



4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 2 (Surfaces 3 and 4) (pi3).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_4.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 4 (Surfaces 7 and 8)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 4 (Surfaces 7 and 8) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 1

d2_clear 0 0 m Clear aperture diameter, surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

R1 R_7 -373.02 mm Radius of curvature, 
surface 1 (+convex/-
concave)

R2 R_8 249.5 mm Radius of curvature, 
surface 2 (-convex/+
concave)

Tc T_7 6.952 mm Center thickness

d0 1.02*max(D_7,D_8) 112 mm Lens full diameter

Name Expression Value Description
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 3 (Surfaces 5 and 6) (pi4).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_6.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 5 (Surfaces 9 and 10)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 5 (Surfaces 9 and 10) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

d1 D_7 109.8 mm Diameter, surface 1

d2 D_8 108.7 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

R1 R_9 -2591.2 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_10 229.24 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_9 11.541 mm Center thickness

Name Expression Value Description
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 4 (Surfaces 7 and 8) (pi5).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_8.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 6 (Surfaces 11 and 12)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 6 (Surfaces 11 and 12) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

d0 max(D_9,D_10) 113.7 mm Lens full diameter

d1 D_9 111.8 mm Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description

R1 R_11 -82.303 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_12 569.82 mm Radius of curvature, surface 2 
(-convex/+concave)

Name Expression Value Description
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 5 (Surfaces 9 and 10) (pi6).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_10.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 7 (Surfaces 13 and 14)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 7 (Surfaces 13 and 14) in the 
Label text field.

Tc T_11 11.524 mm Center thickness

d0 max(D_11,D_12) 149.7 mm Lens full diameter

d1 D_11 114.9 mm Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Expression Value Description
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 6 (Surfaces 11 and 12) (pi7).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_12.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 8 (Surfaces 15 and 16)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 8 (Surfaces 15 and 16) in the 
Label text field.

Name Expression Value Description

R1 R_13 5523.6 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_14 -156.82 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_13 36.703 mm Center thickness

d0 max(D_13,D_14) 170.1 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear D_13 158.9 mm Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 7 (Surfaces 13 and 14) (pi8).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_14.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 9 (Surfaces 17 and 18)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 9 (Surfaces 17 and 18) in the 
Label text field.

Name Expression Value Description

R1 R_15 610.34 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_16 -221.89 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_15 41.168 mm Center thickness

d0 max(D_15,D_16) 203.8 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear D_15 200.4 mm Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 8 (Surfaces 15 and 16) (pi9).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_16.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 10 (Surfaces 19 and 20)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 10 (Surfaces 19 and 20) in the 
Label text field.

Name Expression Value Description

R1 R_17 528.59 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_18 -570.2 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_17 26.903 mm Center thickness

d0 max(D_17,D_18) 208.4 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear D_18 208.1 mm Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 9 (Surfaces 17 and 18) (pi10).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_18.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 11 (Surfaces 21 and 22)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 11 (Surfaces 21 and 22) in the 
Label text field.

Name Expression Value Description

R1 R_19 423.58 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_20 -1396.3 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_19 21.883 mm Center thickness

d0 max(D_19,D_20) 202 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear D_20 200 mm Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 10 (Surfaces 19 and 20) (pi11).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_20.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 12 (Surfaces 23 and 24)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 12 (Surfaces 23 and 24) in the 
Label text field.

Name Expression Value Description

R1 R_21 203.91 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_22 835.45 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_21 22.715 mm Center thickness

d0 max(D_21,D_22) 183.7 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear D_22 179.4 mm Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 11 (Surfaces 21 and 22) (pi12).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_22.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 13 (Surfaces 25 and 26)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 13 (Surfaces 25 and 26) in the 
Label text field.

Name Expression Value Description

R1 R_23 -735.9 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_24 104.64 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_23 8.386 mm Center thickness

d0 max(D_23,D_24) 115 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 D_24 101.1 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 12 (Surfaces 23 and 24) (pi13).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_24.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 14 (Surfaces 27 and 28)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_25 -184.67 mm Radius of curvature, 
surface 1 (+convex/-
concave)

R2 R_26 288.71 mm Radius of curvature, 
surface 2 (-convex/+
concave)

Tc T_25 11.034 mm Center thickness

d0 1.02*max(D_25,D_26) 101.9 mm Lens full diameter

d1 D_25 99.9 mm Diameter, surface 1

d2 D_26 99.2 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 14 (Surfaces 27 and 28) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 13 (Surfaces 25 and 26) (pi14).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_26.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 15 (Surfaces 29 and 30)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_27 -74.566 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_28 2319 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_27 11.343 mm Center thickness

d0 max(D_27,D_28) 126.1 mm Lens full diameter

d1 D_27 103.7 mm Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 15 (Surfaces 29 and 30) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 14 (Surfaces 27 and 28) (pi15).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_28.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 16 (Surfaces 31 and 32)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_29 -283.45 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_30 -142.52 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_29 22.211 mm Center thickness

d0 max(D_29,D_30) 139.8 mm Lens full diameter

d1 D_29 129.5 mm Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 16 (Surfaces 31 and 32) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 15 (Surfaces 29 and 30) (pi16).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_30.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 17 (Surfaces 33 and 34)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_31 -5670.5 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_32 -146.69 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_31 39.484 mm Center thickness

d0 max(D_31,D_32) 172.9 mm Lens full diameter

d1 D_31 163.7 mm Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 17 (Surfaces 33 and 34) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 16 (Surfaces 31 and 32) (pi17).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_32.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 18 (Surfaces 35 and 36)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_33 654.75 mm Radius of curvature, surface 1 
(+convex/-concave)

R2 R_34 -347.71 mm Radius of curvature, surface 2 
(-convex/+concave)

Tc T_33 37.168 mm Center thickness

d0 max(D_33,D_34) 192.7 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear D_33 189.5 mm Clear aperture diameter, 
surface 1

d2_clear 0 0 m Clear aperture diameter, 
surface 2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 18 (Surfaces 35 and 36) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 17 (Surfaces 33 and 34) (pi18).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_34.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 19 (Surfaces 37 and 38)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_35 254.91 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_36 2133.2 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_35 31.6 mm Center thickness

d0 max(D_35,D_36) 192.9 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear D_36 189 mm Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 19 (Surfaces 37 and 38) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 18 (Surfaces 35 and 36) (pi19).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_36.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 20 (Surfaces 39 and 40)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_37 164.8 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_38 349.38 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_37 27.885 mm Center thickness

d0 max(D_37,D_38) 179.9 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 D_38 172 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 20 (Surfaces 39 and 40) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 19 (Surfaces 37 and 38) (pi20).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_38.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Lens 21 (Surfaces 41 and 42)
1 In the Geometry toolbar, click Part Instance and choose Spherical Lens 3D.

Name Expression Value Description

R1 R_39 108.98 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_40 75.67 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_39 73.045 mm Center thickness

d0 max(D_39,D_40) 155.4 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 D_40 93 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Lens 21 (Surfaces 41 and 42) in the 
Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 20 (Surfaces 39 and 40) (pi21).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_40.

7 Locate the Boundary Selections section. In the table, enter the following settings:

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Image
1 In the Geometry toolbar, click Part Instance and choose Circular Planar Annulus.

Name Expression Value Description

R1 R_41 46.284 mm Radius of curvature, surface 1 (+
convex/-concave)

R2 R_42 99.316 mm Radius of curvature, surface 2 (-
convex/+concave)

Tc T_41 16.956 mm Center thickness

d0 max(D_41,D_42) 51.4 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 D_42 39.7 mm Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 
1

d2_clear 0 0 m Clear aperture diameter, surface 
2

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions
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2 In the Settings window for Part Instance, type Image in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Lens 21 (Surfaces 41 and 42) (pi22).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zwi text field, type T_42.

7 Locate the Boundary Selections section. In the table, select the Keep checkbox for All.

8 Click Build All Objects.

9 Click the Zoom Extents button in the Graphics toolbar.

Name Expression Value Description

d0 D_43 25 mm Diameter, outer

d1 0 0 m Diameter, inner
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